**Peters Township High School (McMurray, Pennsylvania)**

**Christopher Allen**  
allienc@pt-sd.org

**PROJECT OBJECTIVE**
Design a 3D printed CO2 dragster based on predefined parameters

**PROJECT OVERVIEW**
This project follows the iterative design method (prototyping, testing, analyzing, and refining the design) to achieve minimum requirements with a primary goal of a project-based approach to vehicle design. This portion of the overall project is completed in a digital format using ANSYS AIM to test aerodynamic design. Results of the fluid-flow analysis are utilized when evaluating vehicle body design prior to manufacturing and racing.

**PROJECT STRATEGY**
This project relies upon the scaffolding method in education culminating with a project-based challenge. Prior knowledge includes parametric modeling techniques, transportation systems, concepts of aerodynamics, additive manufacturing standards, and material science. This project is presented to students in five phases: Research, Design and Simulation, Manufacturing and Assembly, Pre-Race Analysis, and the Race Competition.

**Research Phase:** As an introduction to this project students review current concepts relating to aerodynamics and how these concepts relate to the design of dragsters. Prior knowledge of concepts relating to transportation systems and individual vehicle systems.

**Design and Simulation Phase:** Students begin preliminary designs in the form of rough sketches then move on to technical drawings based on research (Technical Design Worksheet found on page 3). This leads to the parametric modeling phase of the project and then into fluid flow analysis of designs using ANSYS AIM. Results from the fluid flow analysis are evaluated and students use the data to determine changes to designs.

**Manufacturing and Assembly:** Students’ final designs are printed and assembled using the same materials (wheels, axles, and filament material).

**Pre-Race Analysis:** Students evaluate their manufactured CO2 dragster using a wind tunnel and an elevated ramp to complete the Pre-Race Analysis worksheet (found on page 4).
Race Competition: Student designs are evaluated using the *Dragster Design Rubric* (found on page 5) prior to the race competition by the instructor. Students participate in a double elimination competition dragsters are disqualified if vehicle is destroyed during the race.
CO2 DRAGSTER
PRE-RACE ANALYSIS

Name:

1. Width of my car (Max 3 inches)?

2. Height of my car (Max 2.5 inches in rear and max 1 inch in front)?

3. Distance between front and rear axle (minimum 5 inches)?

4. Does my CO2 chamber have holes?

5. Did I need to fix my car with glue prior to my first race?

6. Velocity Data (from ANSYS AIM simulation)

<table>
<thead>
<tr>
<th></th>
<th>Calc. Max</th>
<th>Calc. Average</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

7. Wind Tunnel Test – Place your finished car in the wind tunnel. Conduct two tests for the coefficient of drag (CD). Test 1 should be done without a CO2 cartridge while test 2 should have a cartridge installed in the car

<table>
<thead>
<tr>
<th>Coefficient of Drag (CD)</th>
<th>Test 1 (CD)</th>
<th>Lift</th>
<th>Test 2 (CD)</th>
<th>Lift</th>
<th>Average (CD)</th>
<th>Lift</th>
<th>Class Best/Avg</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Fr</td>
<td>Fr</td>
<td>Fr</td>
<td>Fr</td>
<td>Fr</td>
<td>Fr</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Rr</td>
<td>Rr</td>
<td>Rr</td>
<td>Rr</td>
<td>Rr</td>
<td>Rr</td>
<td></td>
</tr>
</tbody>
</table>

8. Ramp Test – Weigh your car prior to conducting the Ramp Test

<table>
<thead>
<tr>
<th>Car Weight (CW)</th>
<th>Time of Travel (TT)</th>
<th>Distance Traveled (DT)</th>
<th>Distance Off Center (DOC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>grams</td>
<td>sec.</td>
<td>in.</td>
<td>In.</td>
</tr>
</tbody>
</table>

9. Calculate and Analyze Data – Based on the Ramp Test Data, calculate the ramp test accuracy, ramp test speed, and inertia performance for the CO2 car.

<table>
<thead>
<tr>
<th>Ramp Test Accuracy (RTA)</th>
<th>Ramp Test Speed (RTS)</th>
<th>Inertia Performance (IP)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Use the follow equations for your calculations and show your work below

RTA = 100-(DOC/DT x 100)  
RTS = DT/TT  
IP = DT/CW
## CO2 DRAGSTER
### DRAGSTER DESIGN RUBRIC

<table>
<thead>
<tr>
<th></th>
<th>10</th>
<th>7-9</th>
<th>4-6</th>
<th>1-3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality of Design</td>
<td>High quality design with consideration to purpose and transportation theory, student challenged himself/herself with their design</td>
<td>Design has minor design flaws relating to how the car will operate as a system, student challenged him/herself</td>
<td>Design has 1 or more major flaws relating to purpose and transportation theory</td>
<td>Car was designed with no consideration to purpose or theory, student put no effort into design</td>
</tr>
<tr>
<td>Car Symmetry</td>
<td>Car is symmetrical and a mirror image of itself</td>
<td>Car shows 1-2 minor flaws to one side or the other</td>
<td>Car has more than 2 flaws to its symmetrical design</td>
<td>Car is uneven and crooked, runs to one side</td>
</tr>
<tr>
<td>Aerodynamic Design</td>
<td>Every face/part of the car was designed to be aerodynamic</td>
<td>Every face/part of the car was designed to be aerodynamic except for 1-2</td>
<td>Car design lacks aerodynamic design in 3-4 places</td>
<td>Car has been designed without any considerations to aerodynamics</td>
</tr>
<tr>
<td>Wheel/Axle Quality</td>
<td>Wheels spin freely with minimum friction</td>
<td>Wheels spin with slight friction</td>
<td>Wheels spin but only one time around</td>
<td>Wheels do not spin</td>
</tr>
<tr>
<td>Quality of Preparation</td>
<td>Car is sanded and finished smooth (no rough areas)</td>
<td>Some sanding marks and/or rough areas visible</td>
<td>Car has rough areas with minimum sanding effort</td>
<td>Car has not been sanded</td>
</tr>
<tr>
<td>Race Times Recorded</td>
<td>All race time recorded</td>
<td>More than 1 race time recorded but not all race times</td>
<td>Only 1 race time recorded</td>
<td>No race times recorded</td>
</tr>
</tbody>
</table>

**TOTAL POSSIBLE: 60**

**SCORE:**

- Race times should be recorded on the back of the Pre-Race Analysis sheet
- Staple this sheet to your Pre-Race Analysis sheet after all of your races have been completed
1. Export from Inventor as a STEP File
   a. File>Export>CAD Format> STEP File

2. Setup Project
   a. Open ANSYS Aim and in the “Study” window select the “Fluid Flow” process
   b. In the “Fluid Flow Template” window make sure that “Import existing Geometry” is selected and click “Create Simulation Process”.
   c. This will open a window that will allow you to select your STEP file and click “Open”.

3. Finding the Workflow window in the work area
   a. In the center-bottom of the work area you will see the “Work Flow” window which shows the steps you will set up to run the simulation.
b. First click on the “Geometry” tab, which will open the Geometry Process tab in the upper-left corner of the screen.

c. Next click on “Edit Geometry” so that you can add or edit required components to the model that you will be testing.

4. Adding an enclosure to your model geometry
   a. After you clicked “Edit Geometry” in the last step, a model editing window will open. The only thing you will do in this step is add an “Enclosure” around your model.

b. On the top of the toolbar click the “Prepare” tab

c. In the Prepare tab click on the “Enclosure” tool
d. Next you will need to select what will be enclosed in the **enclosure** by click on the body of your model.

![Image](image.png)

e. After selecting the model to enclose, an outline of a **rectangle** will appear to show where the enclosure will be oriented. Before completing this operation you need to change the size of the rectangle by adjusting the **cushion size**.

f. On the **left-side** of the screen look for the “Create Options” window where you can adjust the **enclosure type** and the **cushion size**. Make sure the **enclosure type** is set to “Box” and change the “Default Cushion” to **10%**.

![Create Options](image.png)

g. To complete these adjustments and add the enclosure to your model click on the **green check box in the work area**.

![Check Box](image.png)
h. Finally, to complete this process and return to the simulation work environment click on the “Model” menu in the upper-left corner of the screen and click “Close”.

5. Setting up and generating the Mesh
   a. In the “Workflow” window select the “Mesh” process
   b. In the Mesh settings window on the left of the screen you will need to adjust one error under Mesh Controls.
c. Click on “Mesh Controls” and in the new Mesh Controls menu that opens click on “Inflation”

![Mesh Controls](image)

d. In the “Inflation” menu click the checkbox for “Automatically Defined”

![Inflation](image)

e. Back in the Mesh Process window use the mesh resolution slider to adjust the mesh resolution down to level 1 (as seen in the picture below)

![Mesh Process](image)

f. In the Workflow menu there will be a yellow lightning bolt next to the Mesh button, which signifies that the mesh process needs to be updated and has no other errors at this point. Click on the Mesh tab and in the Mesh Process menu click on the blue lighting bolt to update and Generate Mesh.
6. The Physics Process and adding the Fluid Flow Conditions
   a. In the Workflow window select the “Physics” process which will open the Physics Process window on the left of the screen.
   b. First we need to change the view options so that we can see our model, which is now inside and hidden by the model of the enclosure. **Click on the top of your rectangular enclosure** to turn it orange and then **right-click** to bring up a menu where you will click “Hide Face”.
   c. Next to the words “**Fluid Flow Conditions**” click on the “Add” button and select “Inlet”.

---

---
d. An **Inlet** settings window will open on the **left-side** of the screen and you will need to select where the the fluid, or in our case the air, will be entering the enclosure.

e. On your model select the wall in front of your model, which will turn it orange.

![Inlet settings window](image)

f. Once you have the front of the enclosure selected, **click on the plus button** over in the **Inlet setting window** to add that face as the inlet for your simulation.

![Inlet settings](image)

g. Next you will need to set the **velocity magnitude** of this in-flow as **20 [m s\(^{-1}\)]** in the “**Velocity Magnitude**” box.

![Velocity magnitude](image)

h. Click on the **Physics** tab in the **Workflow** window to return to the **Physics Settings** window.

i. Next you will set the **Outlet** in the same way you set the **Inlet** by clicking the “**Add**” button next the words “**Fluid Flow Conditions**” and select “**Outlet**”.

![Physics Settings](image)
j. This time **click the back of the enclosure, opposite of the inlet**, to set it as the exit point for the fluid, or air, in our simulation. Once you have selected the location for the **outlet** you click the **“plus”** button in the **location** box.

![Outlet settings](image)

k. In the **Outlet settings** window find the “**Flow Specification**” drop-down box and set the flow specification to “**Velocity**”.

![Outlet settings](image)

l. In the “**Velocity Magnitude**” set the velocity magnitude of the outflow as **20 [m s^-1]**

![Velocity](image)

m. Next, you need to set the **walls** of the enclosure by returning to the **physics settings** window. Click the **“Add”** button next the words “**Fluid Flow Conditions**” and select “**Wall**”.

![Physics settings](image)
n. This should automatically turn everything on your model **blue except the Inlet and Outlet faces**, while at the same time automatically adding all of the faces to the **location** box in the **“Wall Setting”** window on the left of the screen.

7. **Solve Physics**
   a. Return to the **Physics Process** window by clicking on **Physics** in the **Workflow** window.
   b. Click on the blue **“Solve Physics”** button at the bottom of the window. This process might take up to 15 minutes to complete depending on your design.
8. Evaluate Results
   a. In the **Workflow** window select the “**Results**” process which will open the **Results Process** window on the left of the screen.

   ![Workflow window](image)

   b. Click on “**Results**” and the **Velocity Process** window will open to show a summary of your simulation.

   ![Velocity window](image)

   c. Under the “**Symbol Distribution**” drop-down box, change the option to “**Based on Mesh**”. Then under the “**At every Nth element**” box change the number to a value of 150, you may also experiment with this number to get better results but any number above 1000 will slow down your computer. After you have made your adjustments you will need to click on the “**Evaluate Results**” again.

   ![Velocity window](image)
d. In the center of the work area you will see a play and button which, when pressed, will play your simulation.

9. Evaluate Results
a. With your simulation running, navigate around the and look for areas of your design that show areas of **dark blue arrows**, which are areas of the lowest velocity and where your design has the most drag.

b. Arrows that are warmer colors, yellows to reds, show where your design has the least amount of drag. Cooler colors, dark blues to light blues and greens, show the areas with the most drag (see examples below).
10. Document Results
   a. Following your evaluation from the last step, find and document areas of your design showing the following results:
      i. 1 image showing your full side view
      ii. 1 image showing a top-down view
      iii. 2 images showing areas of the most drag
      iv. 2 images showing areas of the least drag
      v. 2 images showing areas with arrows flowing in the negative direction

   b. To save the required above pictures use the next step (Step 11) to learn how to save the pictures.

11. Save Image of your test
   a. Right-Click on your design and then click “Save Image As…”
b. In the “Save Image As” box that opens click on the button to the right of the “File” box that has 3 dots and select your H: Drive to save each picture.

c. Open and print out your pictures making sure to write on them what of the required pictures in Step 10 (also seen below) is shown

i. 1 image showing your full side view

ii. 1 image showing a top-down view

iii. 2 images showing areas of the most drag

iv. 2 images showing areas of the least drag

v. 2 images showing areas with arrows flowing in the negative direction